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Esittely

SeaClear on Pc-pohjainen karttaplotteri. Yhdistettynd GPS:44n se ndyttdd aluksen reaaliajassa
kartalla sisdltden paikkatiedon, nopeuden, suunnan ja paljon muuta.

Kartat SeaClear:issa ovat rasterityyppié ja niiti on kaupallisesti saatavissa BSB/KAP ja GEO/NOS
karttoina, tai niitd voi valmistaa paperi- tai kuvaruutukopioista.

Kartta liikkuu niin ettd alus on aina nikyvissi ja uusia karttoja ladataan tarvittaessa jos
automaattinen lataus on kytkettyna.

Reittejd voidaan helposti tehdi ja kdyttda navigoinnin apuna. Seuranta voidaan néyttid, tallentaa
ja muuttaa reiteiksi. Kiintopisteitd voidaan kéyttaa erityisien paikkojen nopeaan etsimiseen tai
reittien luomiseen. Jotta mahdollisimman suuri osa karttaa voidaan pitda ruudulla, oikea hiiren
nappulan painallus avaa ponnahdusvalikon jonka kautta pddstdan késiksi useimpiin toimintoihin.

Néayttopaneeli ndyttdd tiedot GPS:std, aktiivisen reitin ja muuta ajankohtaista informaatiota.
Karttaruudun maksimoimiseksi ndyttépaneeli voidaan tilapdisesti poistaa ndytosta.
Néyttopaneelilla voidaan sddtdd useita toimintoja. Manuaalisessa tilassa siind on yldvalikko jonka
kautta pdédsee nopeasti eri toimintoihin. Jos GPS-tietoa ei ole saatavilla "DR”-paneeli joka sallii
nopeuden ja suunnan sy6ttdmisen korvaa nédyttopaneelissa GPS-paneelin paikan. Jos NMEA tieto
nopeudesta tai suunnasta on saatavilla (NMEA yhteensopiva kompassi ja/tai loki) se voi jatkaa
"DR”-paneelin pdivittdmistd. T4lld perusteella voidaan laskea oletettu paikkatieto kartalla.
Hiiriosoittimen muoto néyttdd kulloinkin missi toimintatilassa ohjelma on.

Ohjelman otsikkopalkki ndyttda kédytossd olevan kartan, mittakaavan ja tutkakehén

etdisyyden. Suurin osa tiedoista voidaan tulostaa. Kaikki listat voidaan my®os tallentaa tiedostoihin
esikatseluikkunoista.

Huomaa: Kaikki viittaukset SeaClear:iin tai Mapcal:iin tdssd ohjeessa tarkoittavat ohjelmia SeaClear_2.exe ja Mapcal_2.exe

5/36



N&ytto

Otsikkopallkki

15
s

'ﬂ/h}ﬁyﬁﬁpaneli

G Vene

e

Kartta-alue

Kiintopiste

Tutkakeha

Tosisuunta Vene

Al=lzn !

(3
]
.

Frs 1
G annen :

Reittipiste

Reittiviiva Tuuliosoitin

6/36

SeaClear MMIII



SeaClear MMIII

Nayttopaneeli

Riippuen yhdistetyistda NMEA-laitteista, ndyttopaneelin tekstit voivat vaihdella. My6s nédyton koko
voi rajoittaa ndkyvilld olevia tietoja. Jotta kaikki olisi ndkyvissd ndyton kooksi tarvitaan 1024 x 768.
Tiedot nédkyvit vain jos néaytolld on tarpeeksi tilaa.

File Tz 3» Padwmlildo
[GF D GPSs-tiedot. Jos Hedot puithrmt, mnrthm punaiselisi
LI o I L' Leweyspiiri
01756 5508 E Pitimspiivi
con 223.2° :;Jsimmmtd e
| O oo susen
{UTC o047 ke Péusiiys ja hello (UTC) GPS:oti
Lem  §2147  GPStctoon perustiom lold
Tip 059 O samathamittari (nollans=hlikhkan oiliealla)
Four 746 Edyttihmtimittari (nollans=klikkaa oikealla)
[Plixs | Kiintopistevarasto
I '1 Valitse kiintopiste

Find Position
Dpen Nowte
Neverse Moule
Achivote Moule
[Becte Staislics.

Etsi piste, lataa kartta jos tarpeen
Peitticen pikawmlinnat

Ladatim reitin tedot

Stai: WP 0
Erc. WPE 20
Cit 004
[Ferh
! 2 ! B.I m S . --. Vﬂ_‘in jus NMEA—] -] II--] w0 .ﬁ]]n
Fd Tumliticdot. Vain jos NMEA-tmilimittari
IS5 O.GBM Tosismmin ja nopcus
ISR 216G Suhbecllinen ja maantictecllinen simmta
| P 0.kt Nopcus tmlen subtecn
e R .
220 D © Kompassiozoitus. Vain NMEA-kompaszilla
[ZcuEleCick Valitse mittans tai ke skdtys lnm karttan kakzoizkdikatanan
| wRAIIE |_ T
Ghadng Nayton drldinwden wmlinta
e
CauToMaTicorr | Klildoa sutomantti péfille ‘pois
TNACK OIT Eliklnna seiranta phdlle spois
Elikhnn NMEA-ulostule padlle pois lnm reitt on akidvoitn
_b-!'l_'-l?!.:l-l.:.i:‘l_ﬁ_ Kwrsori  Mittans / Merhld paikln, sinmta ja etdisyys
MmMaMaT 22 FE Kim mittans, vHri on Bmeth
1157 0L 40N M Kim merkld on asctetin, wHrl on symoni
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Reittisuunnittelu SeaClear:illa

Tietokoneohjatulla navigoinnilla on monia etuja. Koska PC voidaan kantaa aluksesta, paljon
suunnittelua voidaan tehdi etukiteen. Kartat ja alueet voidaan nopeasti skannata,
mielenkiintoiset paikat tallentaa ja reitit suunnitella huolella etukiteen.

Liikkuminen

Suunnittelun aikana "automaatti”-tila pitda olla pois pdita. Kursori on silloin risti [
Senhetkinen kursorin paikka, ja paikka suhteessa alukseen, ndytetdin paneelissa.

Karttaa liikutetaan painamalla hiiren vasen nappi pohjaan ja siirtdmalla hiirtd napin ollessa
painettuna. Koko kartta liikkuu hiiren mukana.

"Keskita”-tilassa kaksoisklikkaus vasemmalla lataa parhaan kartan kursorin kohdalta ja jos jo
ladattu kartta on paras kartta, toimenpide keskittdd kartan kursorin kohdalle.

Jos rullahiiri on kédyt6ssé, rullaa voidaan kayttdd kartan ldhentdmiseen ja loitontamiseen (zoom).
Zoomaus keskitetddn kursorin kohdalle.

Karttaluettelon selaamiseksi klikataan hiiren oikealla napilla ja valitaan "kartta”-valikko uusien
karttojen valitsemiseksi.

T

=5
Kun ollaan kartan reunalla, kursoriin tulee nuolet, 4" osoittamaan ettd ollaan
kartanvaihtoalueella. Kun kaksoisklikataan oikealla hiirinapilla uusi kartta ladataan aina vaikka sen
mittakaava olisi pienempi. Ndin tapahtuu my6s mittauksessa tai reitinmuokkaustilassa.
Klikkaus GPS-paneelin pailld keskittdd senhetkisen GPS-paikan ruudulle. Jos paikka on pois
kartalta, paras kartta ladataan. Kaksoisklikkaus lataa parhaan kartan.
Kaksoisklikkaus kartalla voi myods mitata matkaa ja suuntaa jos niin on valittundyttépaneelista.
” Mittaus”-tilassa kaksoisklikkaus vasemmalla hiirinapilla aloittaa mittauksen. Kaksoisklikkauksen
toisessa klikkauksessa pitdd jattda hiirinappi pohjaan, jonka jélkeen hiirtd aletaan siirtda
mitattavaan kohteeseen nappi edelleen pohjassa. Etdisyys ja suunta paivittyy ndyttépaneelin
"kursori / merkki”-osaan. "Automaatti”’-tilassa mittaus kaksoisklikkaamalla on aina aktiivisena.
Valitse paikkatiedoista paikka ja klikkaa "Etsi paikka”. Jos paikka on nykyiselld kartalla kartta
keskitetddn paikkaan. Jos ei, paras kartta ladataan ja keskitetddn.

Paitsi selailua, mielenkiintoiset paikat voidaan tallettaa ja reitit luoda. Koska reittejd voi yhdistelld
voidaan kokoelmaa lyhyiti reittejd kayttdd pidemmilldkin matkoilla.

Reitit, paikat ja muu tieto voidaan printata tai tallentaa tekstitiedostoihin. Kaikki listojen tiedot
tallennetaan pilkkuerottimilla jolloin tiedostoja voidaan avata monissa eri sovellusohjelmissa.

Kiintopisteet

Kiintopisteitd voidaan kdyttdd sekd mielenkiintoisten paikkojen merkintidn, ettd reittipisteina.
Lisdksi reitit voidaan avata kiintopisteini jolloin voidaan uudelleenkéyttia reitin osia. Koska
pisteet pitdd aina nimetd, ja kahta samannimista pistetti ei voi ladata, saattaa ollaetteivit kaikki
reittipisteet eivdt lataudu.

Uusi kiintopiste lisdtddn klikkaamalla oikealla napilla halutussa pisteessi ja valitsemalla
"Kiintopisteet”>"Lis&4 ..” aluksen tai kursorin paikka. Dialogi avautuu johon voidaankirjoittaa
kiintopisteen nimi ja tiedot.

Olemassa olevan reittipisteiden muokkaus voidaan tehd4 valitsemalla se kiintopistepaneelista ja
sitten kaksoisklikkaamalla paneelia, tai valitsemalla "kiintopisteet” >"vapauta” pddmenusta. Sen
jalkeen on mahdollista raahata pistettd hiiren vasemman napin ollessa alhaalla ja
kaksoisklikkaamalla pisteen pdilla saa avattua tietojen syodttddialogin korjauksia varten.
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Reitit

Esittely

Reitti on kokoelma reittipisteitd joita yhdistdd nopeus- ja virhepoikkeamatiedot ja jota
kaytetddn navigoinnin apuna. Kun reitti aktivoidaan, vastaava paneeli ndytetdan
nédyttdpaneelissa.

Reittien teko

Reitit tehdddn ja muutetaan reittieditorissa. Editori kdynnistettddn valitsemalla padvalikosta
"Muokkaa”>"Reitin muokkaus”. Nayttopaneeli ndyttdd tiedot valituista reittipisteistd,
pikavalinnat ja padvalikko muuttuu.

i i i i

Kursori vaihtuu reitin lisdystilassa I tai laajennustilassa
Reittipisteet luodaan kaksoisklikkaamalla hiiren vasemmalla painikkeella kursorin ollessa
halutussa kohdassa karttaa, tai valitsemalla esiasetettuja kiintopisteitd. Lisdystilassa (oletus)
reittipiste lisdtd4n kahden olemassa olevan, ldhimman, reittipisteen viliin. Laajennustilassa
reittipiste lisdtd4dn olemassa olevan reitin loppuun.
Reittipistettd voi siirtdd viemalld kursorin pisteen péille, painamalla vasemman hiirinapin
pohjaan ja siirtdmall4 hiirtd pitden vasen nappi pohjaan painettuna. Reittipisteen tietoja voi
muokata reittipisteosassa nayttdpaneelia.
Useita reittipisteitd voi valita pitdimélla CTRL-nappi alaspainettuna samalla kun klikkaa hiiren
vasemmalla napilla. Tai pitimalla Shift-nappi pohjassa voidaan valita nykyisestd aktiivista
reittipisteestd ldhtien kaikki pisteet klikattuun seuraavaan pisteeseen saakka. Valittuja
reittipisteitd voidaan editoida, tai ne voidaan poistaa. Jos editoidaan useita reittipisteitda
kerrallaan paikkoja ei voi muuttaa, eivétka tyhjit tai 0-arvoiset tiedot péivity.
Reitinmuokkaustilassa ndyttopaneeli ndyttdd seuraavalta:

File »z Reitti paavalikko

[Biouitz W zypaint Valitun reittipisteen tiedot
;.-ilstan 'i BReittipistelista
Lat IDﬁS' 131000 Reittipisteen leveyspiiri

Lur|g|01?"55483 E Reittipisteen pituuspiiri

Saeed i EAll ;i Arvioitu nopeus

C =
=TEMax I 0,750 ;i Suurin sallittu poikkeama reitilta

T Ame
;rllzren Reittipisteen nimi
Update Péivita sydtetyt tiedot
Delate Seloctad Poista valitut reittipisteet
| OpenRowe | Pikavalinnat
Save Houte
| Jlpar Hinate
Lzt Rnaite
Cloze Editos
Add Posiion | Liséd valittu paikka reittiin
[Fratnnz Paikkatietopistevarasto
Find Pozition
[Flout: Sodhistize Ladatun reitin tiedot

Ttark Alslen
Erd: Kungzhalk
Dizt: 279

Kun reittipiste valitaan listalta se keskitetdan kartalle. Jos nykyiselld kartalla ei ole pistettd,
paras kartta ladataan.

Huomaa: Reitinmuokkaustilassa aluksen kulkutiedot silti pdivittyvit GPS:sta.
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Navigointi SeaClear:illa

Ennen matkan aloittamista tarvittavat reitit pitda ladata. Silloin on mahdollista jattda SeaClear
toimimaan yksindédn, jolloin aikaa jaad enemmaén muille tehtéville.

Navigoidessa "automaatti”-tila pitd4 olla valittuna. Karttaa péivitetddn niin ettd alus pysyy
nékyvissd ja uusia karttoja ladataan tarvittaessa. Jos reitti on ladattu se pitda aktivoida jotta
tiedot saadaan ndkyviin. Jos seuranta on péilld aluksen jattdma jalki piirretdén ja tallennetaan
levylle. "Automaatti”-tilassa hiiriosoitin on oletusarvossaan (nuoli).

Reittien kaytto

Ennen matkan aloittamista lataa tarvittavat reitit ja aktivoi reitti. Useita reitteja voidaan
yhdistd4, ja jokainen uusi reitti lisdtddn parhaassa paikassa tai laajennetaan jo ladattuihin
reitteihin. Useita reittejd voidaan valita kerrallaan reittitiedoston avausdialogissa. Jos Shift-
nappia pidetddn pohjassa valinnan aikana valitaan ensin valituista ldhtien kaikki seuraavaan
valintaan asti. Jos Ctrl-nappia pidetddn pohjaan painettuna voidaan valita listalta hajanaisesti
eri reittejd ladattavaksi kerralla.

Aktivoinnissa, jos nykyinen paikka on viimeisell4 reittiosuudella, reitti kddnnetdan
automaattisesti. Jos nykyinen paikka ei ole reitin kummassakaan padssi lasketaan paras
alkupiste (1dhin) reitille.

Kun reitti aktivoidaan, kohteena oleva reittipiste korostetaan janédyttdpaneeli siirtyy
ndyttdmadn navigointia helpottavia tietoja. "NMEA ulos”-painike on ndkyvissi ja oletuksena
pois pdiltd. Kun se on piilld reitin tiedot ldhetetddn NMEA-laitteelle (autopilotti). Lihetyksen
sisdllon voi valita asetusvalikosta.

Seuraavanlaiset tiedot ovat ndkyvissi nayttopaneelissa:

R PeitHpisteen nimi

B {92 2° BWE: sinmitna rwittpisteczecn

“TE 0.04 HH XTE: poikkeama reittiviimlta

@ 164 0" BOD: sinmtn lahtépistee sti holteczeen
TN 0.0kt WCV: reittipisteen labe stymisnopens

EM3 D.AHM PNG: ctfisyys reittpistec scen

TR 00-/0549 TTG: ailn reitbpistecn saavuattamiscen
TOIHG DONH  TRNG: ctiisyys reitin loppinm

TR 99:59549 TTTG: aika rwitin lopmom nylyizelld nopendella
LET M6 5" NEXT: sciuranawm sinmin

JIkE 000056  TIME: mili reitin aldivoinnista
}:{{{{{{{{{ 1l Ohjausohjc, miten pysyi reitilld

Suunta-osoitusten vaihtaminen tosisuunnan ja magneettisuunnan vélilld tapahtuu
reittimenusta joka aukeaa klikkaamalla oikealla hiirinapilla reittitietojen pailla. Jos sallittu
reittipoikkeama (XTE) ylitetddn muuttuu ndyton XTE-arvo punaiseksi. Jos asetuksissa on
madritelty reittipisteen hyvdksyminen muuttuu ndyttdpaneelin reitti-osa punaiseksi kun
reittipiste on saavutettu ja seuraava piste siirtyy aktiiviseksi. Hyviaksyntd voidaan tehda
ndppdimistoltd tai edelld mainitusta menusta josta tosisuunta ja magneettisuuntakin
vaihdettiin.

Kun "automaatti”- tila on pdill, ja reitti on aktiivisena, ei pddvalikkoa ole ndkyvissa
kiintopistepaneeli on piilotettu ja editointi ei ole mahdollista. Useimmat pikandpp&dimet
ndppdimistolld silti toimivat. Kartan zoomaus on mahdollista ja pienemman mittakaavan
kartta voidaan ladata. Jos paikka muuttuu paras kartta uudelleenladataan 20 sekunnin
kuluttua. Reitin voi lopettaa ennenaikaisesti reittimenusta 16ytyvalld "lopeta reitti”
painikkeella.
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Seuranta

Kun seuranta on paélld aluksen kulkema reitti tallennetaan tiedostoon ja piirretdédn jalkena
kartalle. Pdivays, kellonaika, paikka, suunta ja nopeus tallennetaan. Seurantatiheys asetetaan
asetuksissa. Tiedostonimi luodaan automaattisesti pdaiviyksen ANSI-muodosta, tiedosto
20020304.TRC on maaliskuun 4 pdiviltd vuonna 2002. Jos pdivdys muuttuu matkan aikana
seuranta jakaantuu kahteen eri tiedostoon. Kun seuranta on pois pailtd seurantatiedostot
voidaan avata ja ndyttdd, tulostaa ja muuntaa tekstitiedostoiksi. Seurantatiedostoja voidaan
myos kayttda reittien teossa.

Lokikirja
Elektroniseen lokikirjaan voidaan tallettaa aika, paikka ja viesti tekstitiedostoksi jota voidaan

kdyttdd manuaalisiin tai automaattisiin lokimerkintoihin. Lokikirjaa voidaan katsella milla
tahansa tekstieditorilla. Tiedostonimi ja kansio asetellaan asetuksissa.
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Karttaryhmat

Karttojen jarjestelyd varten SeaClear:issa on mahdollisuus ryhmitelld karttoja. Ryhmittely on
valinnainen. Jos ryhmittelyd ei ole mééritelty kaikkia karttoja kdytetddn samanarvoisina. Haun
aikana valituista ryhmistd haetaan ensin. Jos haluttua karttaa ei 16ydy valitusta ryhmastd, kaikki
kartat kdydddn 1dpi. Jos mikd tahansa kartta 10ytyy halutusta ryhmast4, se valitaan, riippumatta
mittakaavasta.

24 ryhméi voidaan luoda. Jokainen kartta voi kuulua mihin tahansa ryhméan. Ryhmié
kaytetddn haluttujen karttojen automaattiseen lataukseen, ja reittisuunnittelun aikana.

Halutut ryhmét automaattilataukseen ja suunnitteluun ovat toisistaan riippumattomia niin
ettd suunnittelussa voidaan kayttia eri karttoja kuin automaattilatauksessa.

Karttaryhmien maarittely ja luonti

Ryhmien ja ja karttojen valinta tapahtuu paadmenun valinnalla "Muokkaa”>"karttaryhmét” joka
avaa jarjestelydialogin. Ryhmien kaytt6 edellyttdd ettd ne ensin maéritellddn ja nimetdan
"ryhmaéasetukset” vililehdelld. Kartat ryhméén valitaan vélilehdelld "jarjestd kartat”. Useita
karttoja voidaan valita Shift tai Ctrl ndppdimen ollessa painettuna listalla liikuttaessa.

Halutut automaattisesti ladattavat kartat méaritelldaén vélilehdelld "ryhmé&n automaattilataus”.
Kun ”automaatti”-tila on péilld voidaan halutut ryhmat valita klikkaamalla karttaa oikealla
hiirinapilla ja valitsemalla "Oletuskartta”.

Karttaryhmien kaytto

Kun ”automaatti”-tila on péillad kartat haetaan valikoiduista automaattilatausryhmistd. Muita
karttoja kdytetddn vain jos ryhmiin ei sisélly tarvittavaa karttaa. Halutut ryhmét voidaan valita
klikkaamalla karttaa oikealla hiirinapilla ja valitsemalla "Oletuskartta”.

Reittisuunnittelussa, kun "automaatti”- tila on pois péiltd, erilliset halutut ryhmét voidaan
asettaa klikkaamalla karttaa oikealla hiirinapilla ja valitsemalla "Oletuskartta”
ponnahdusmenusta. T4lld tavoin voidaan valita eri karttaryhmét suunnittelussa
kaksoisklikkaamalla karttaa.

Kéytd "kartta”>"etsi kartta” ponnahdusvalikosta karttojen laajennettuun hakuun vain valituista
ryhmista.

Poista valikoidut ryhméit kokonaan saadaksesi kaikki kartat aktivoitua. "Automaatti”- tila,
suunnittelu ja haku kayttavat erillisid hakuryhmia.

Karttajako nédyttdd halutut kartat (niiden peittoalueen aédriviivat) sekd ruudulla,ettd tulosteissa.
Kaikki kartat saadaan karttajakoon poistamalla kaikki valinnat ponnahdusvalikon
"Oletuskartat” listalta.

Jos uusia karttoja 16ydetddan MapCal-ohjelmalla niitd ei automaattisesti lisdtd mihinkdan
ryhmaéén vaan se pitdi tehdd késin. Jos yhtddn haluttua ryhmaai ei ole valittu, niité silti
kdytetddn. Ponnahdusvalikon "kartta”>"paikalla” ja "ndyt4 kaikki” nayttavat kaikki kartat
riippumatta ryhmittelysta.

12/36



Valikot

SeaClear MMIII

Saatavilla olevat valikot vaihtelevat riippuen kulloinkin valittuna olevasta toimintatavasta.
Suunnittelutiloissa pddvalikko on nikyvissd josta tiedostotoiminnat ja muut ei
paikkasidonnaiset toiminnot valitaan.

Ponnahdusvalikot, jotka saadaan esiin hiiren oikeaa nappia painamalla, muodostavat nopean
tavan valita eri toimintoja riippuen hiiriosoittimen paikasta jossa ponnahdusvalikko avataan.

Suunnittelutilan paavalikko

Tiedosto

Kartta

Reitti

Naytid kaikki: Naytd kaikki automaattilatauslistalla olevat kartat.

Etsikartta:  Avaa tarkemman karttahaun dialogin.

Edellinen: Lataa edellisen kartan.

Muut kartat: Avaa kartan joka ei ole automaatilatauslistalla, pitdd olla kalibroitu
kartta.

Karttajako:  Piirrd kaikkien saatavilla olevien karttojen peittoalueet (dériviivat)
valitun kartan péélle. Vain automaatilatauslistalla olevat kartat otetaan huomioon.
Saman mittakaavan, aina 2-50 x nykyinen mittakaava (valittavissa asetuksista)
huomioidaan. Peittoalueet tallennetaan karttojen mukana ja niilli on sama muoto
ja suunta kuin tallennettaessa. Jos karttoja on ryhmitelty, vain halutut kartat
otetaan huomioon.

Tulosta kartta: Tulostaa valittuna olevan kartan. Valinnaisena tulostus voi sisdltdd
reitin, kiintopisteet, seurannan ja rajauksen. Reitti ja kiintopistevalinnoissa on
kolme tasoa joista kun valittuna, mutta harmaana, ei tekstimerkint6jd tulosteta.
Tulostusalue voi olla joko koko kartta, tai ndytossd nékyva osa. Paperin asettelu
valitaan niin ettd saadaan suurin tulostusalue riippumatta tulostimen
asetuksista.

Tulosta lista: Tulosta tdydellinen lista kaikista kartoista sisédltden nurkkapisteet
ja mittakaavan.

Avaa: Avaa uusi reitti. Useita reittejd voidaan valita kerralla Shift tai Ctrl-
nédppdinten avustuksella hiirivalinnassa.
Poista: Poista reitti muistista.

Vie NMEA:han: Lahettda kaikki reittipisteet NMEA-porttiin WPL ja RTE-lauseina.
Tulosta: Tulostaa ladatut reitit.

Kiintopisteet

Avaa: Useita tiedostoja voidaan avata kerralla. Kéytd Shif tai Ctrl-nappia
ja hiirtd. Huomaa ettd samannimisistd tiedostoista vain ensimmaéinen voidaan
avata.

Talleta: Talleta ladattuna oleva reitti uudelleen.

Talleta nimellé: Talleta ladattuna oleva reitti uudella nimella.

Poista: Poista kaikki reittipisteet muistista.

Vapauta: Mahdollistaa kiintopisteiden valinnan, siirron ja poiston. (Ei

"automaatti”’- ja "reitinmuokkaus”-tiloissa).

Poista valitut: Poistaa valitut kiintopisteet muistista.

Tuo tiedosto: Waypoint+ tai G7ToWin tiedostomuodon lataus.

Vie tiedosto: Waypoint+ tai G7ToWin tiedostomuodon talletus.

Vie NMEA:han:Lihettdd kaikki kiintopisteet NMEA-porttiin WPL-lauseina.
Tulosta: Tulostaa kaikki ladatut kiintopisteet.

13/36



SeaClear MMIII

Seuranta

GPS

Avaavanha: Avaa aiemmin talletettu seurantatiedosto ja ndyti se.

Tuo tiedosto: Muuntaa Waypoint+ tai G7ToWin seurantatiedoston SeaClear-
muotoon

Talleta .TXT Tallenna ndytdssé oleva seurantatieto pilkuilla erotetuksi
tekstitiedostoksi. Aika, paikka nopeus ja syvyystiedot talletetaan. Paikat
tallennetaan desimaaliasteina jotta ne on helppo vied4 toisiin ohjelmiin.

Tulosta: Tulostaa aktiivin seurannan. Voi olla nykyinen seuranta, tai vanha
ladattu seurantatiedoston sisélto.

Vie GPS:ddn: Lihetd ladattu reitti ja/tai kiintopisteet GPS:dédn.
Tuo GPS:std: Tuo GPS:sté kiintopisteet, reitti tai seuranta.

Tamad valikko on kédytossad vain jos G7ToWin-ohjelma on SeaClear:in hakemistossa
(erillinen apuohjelma).

Kartan tiedot

Néaytd ladatun kartan tiedot.

Lopeta

Lopeta SeaClear-ohjelman ajo.

Muokkaa

N&ytén kirkkaus

Valitse ndyton himmennys. 1= ei himmennystd, 4= maksimi himmennys. Jokainen
valinta on sdddettdvissi asetuksista kdsin.

Reitin muokkaus

Avaa reitinmuokkaus-editori.

Ominaisuudet

Avaa asetukset-dialogi muokkausta varten.

Karttaryhmat

Avaa karttaryhmienjérjestely-dialogi.

Jarjestelma

— Naytd NMEA sisddn erillisessd monitori-ikkunassa.
- Néytd NMEA ulos erillisessd monitori-ikkunassa.

Ohjelmasta

>>

Avaa ikkunan jossa tietoja SeaClear ohjelmasta.

Piilottaa ndyttépaneelin niin ettd koko ruutu kdytetdan kartan néyttdmiseen.
Néyttopaneeli palautuu siirtdmaélli hiirikursori ndytén reunan yli.
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Reittisuunnittelun
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paavalikko

Tiedosto

Reitti

Avaa: Avaa uusi reitti. Useita reittejd voidaan avata kerralla. Kéytd
Shift/Ctrl ndppdimii ja hiirta.

Talleta: Talleta ennalta valitulle tiedostonimelle. Jos useita reittejd on
avoinna tiedostonimi on tyhjd.

Talleta nimelli: Talleta reitti uudelle tiedostonimelle.

Liité tiedosto: Liitd aiemmin talletettu reitti tiedostosta avoinna olevaan reittiin.
Tuo tiedosto: Waypoint+ tai G7ToWin tiedostomuodon lataus.

Vie tiedosto:  Waypoint+ tai G7ToWin tiedostomuodon talletus.

Vie NMEA:han: Lihetd WPL- ja RTE-lauseet sarjaporttiin liitettyyn NMEA-
laitteeseen.

Néaytédreitti:  Avaa luettelon kaikista raitin reittipisteista.

Kéddnni reitti: K&dntda raitin alkupisteen loppupisteeksi.

Poistareitti:  Poistaa kaikki ladatut reittipisteet.

Tulosta: Tulostaa kaikki ladatut reitit.

Avaa kartta

Naytid kaikki: Nayta kaikki automaattilatauslistalle rekisterdidyt kartat. (MapCal)
Edellinen: Avaa viimeksi avoinna ollut kartta.

Listaamattomat: Avaa karttatiedosto joka ei ole automaattilatauslistalla.
Karttajako: = Kddnné karttajako péille/pois. Vain karttojen, jotka ovat
automaattilatauslistalla, peittoalueen ddriviivat ndytetdan.

Avaa kiintopisteet

Avaa uusi kiintopistetiedosto.

Lopeta muokkaus

Sulje reitinmuokkauseditori.
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Ponnahdusvalikot
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Oikea hiirindppdin aktivoi ponnahdusvalikot. Hiirikursorin paikka jossa aktivointi tapahtuu
madrdd valikon toiminnot. Jotkin toiminnot ovat kopioita padvalikosta nopeampaa kayttdod

varten.

Ponnahdusvalikon péaavalikko

Kartat

(ei valittavissa "automaatti”- tilassa)

Tarkin kartta: Etsi jalataa paras kartta nykyiselle paikalle.

Etsi alus: Etsi alus kartalta.

Pienempi mittak.: Valitse saman paikan pienempimittakaavainen kartta.
Edellinen: Lataa takaisin edellinen kartta.

Paikalla: Listaa kaikki paikkaan sopivat kartat.

Etsi kartta: Avaa laajennetun hakudialogin.
Naytid kaikki: Nayttda kaikki asennetut (MapCal) kartat.

Oletuskartta

Valitse haluamasi mittakaava sekd "automaatti’-, ettd "suunnittelu”- tilaan.
Kaksoisklikkauksella paras kartta. Jos "automaatti”-tila on pdalld,
automaattilatauslista halutuista karttaryhmistéd néaytetddn. Lihin mittakaava valitaan.
Kéytd up/Down-nappeja muuttamaan arvoa, "M” asettaa maksimi mittakaavan,
"Esc” sulkee ilman muutoksia. "Tarkin kartta”-valikko néyttia silti suurimman
laajimman mittakaavan kartan kohteelle.

Reitti

Avaareitti: Valitse reittitiedosto ja lataa se.

— Kaidnndreitti: Kddnnd ladatun reitin alkupisteet loppupisteeksi.

Valitse reitti: Aktivoi reitti ja ndytd reitin tiedot ndyttopaneelissa.

Kiintopisteet

Zoom

Lisdd kursorin paikka: Lisdi kiintopiste kursorin kohdalle.
Lisdd aluksen paikka: Lisdi kiintopiste aluksen kohdalle.

Avaa: Avaa kiintopistetiedosto.
Poista merkki: Poista merkkipiste.
Kursorimerkki: Aseta merkkipiste kursorin kohdalle. Muuttaa

ndyttopaneelin "Merkki / Kursori”-osan ndyttdmaan merkkipisteen paikkaa,
suuntaa ja etdisyyttd alukseen. Nayttd-osa muuttuu Syaanin vériseksi.

Zoomaa kartta ennalta asetettuun %:iin. Toisissa jarjestelmissd zoomaus hidastaa
tietojen pdivittymistd dramaattisesti. Toisissa taas mitddn muutosta ei havaita.

Tydkalut

Lokikirjamerkintd: Aseta manuaalinen lokikirjamerkinta.
Aseta DR-paikka: Aseta DR paikka (siirrd alus kursorin kohdalle). Ei kdyttod jos
GPS on kytketty.

Virkistd ndytto: Pdivitd naytto ajan tasalle.
Ominaisuudet: Avaa ohjelman asetusdialogi.
Poistu: Lopeta SeaClear-ohjelma.

Mies yli laidan

Aseta MOB-merkki aluksen nykyiseen paikkaan

16/36



SeaClear MMIII

Ponnahdusvalikko reittieditorissa

Kun oikeaa hiirindppdintd painetaan reittieditorissa, seuraavat toiminnot ovat
valittavissa:

Paras kartta

Etsi paras kartta kursorin kohteelle

Lisaa karttoja

- Paikalla: Listaa kaikki paikkaan sopivat kartat.

- Edellinen: Lataa takaisin edellinen kartta.

- Pienempi mittak.: Valitse saman paikan pienempimittakaavainen kartta.
— Naytd kaikki: Nayttdd kaikki asennetut (MapCal) kartat.

Laajenna

Kaikki kiintopisteet lisdtddn mukaan

Zoom

Zoomaa kartta ennalta asetettuun %:iin.

Huomaa: Jotkin toiminnot eivét ole valittavissa kun ”automaatti”-tila on p&élld tai reitti on aktivoitu.
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Néppédimistopikavalinnat kdyttden apuna Ctrl ja kirjain-, numero-, tai Funktiondppéinta

Ctrl+vililyonti:
Ctrl+' Atai F2:
Ctrl+'B' tai F9:
Ctrl+'C' tai F8:
Ctrl+' I’
Ctrl+'E":

Ctrl+' F' :
Kartalta.
Ctrl+'G":
Ctrl+'H’ tai F6:
Ctrl+'L' tai F7:
Ctrl+'N' tai F5:
Ctrl+'O’ tai F12:
Ctrl+' Ptai F4:
Ctrl+Q:

Merkitse Mies yli laidan-piste (MOB)

"Automaatti”-tila paalle/pois

Etsi alus ja paras kartta

Haluttu karttamittakaava

Néayttopaneeli, Ndytd/piilota

Vaihda Mittaa / Keskitd

Etsi alus nykyiseltd kartalta. Parempi kartta ladataan jos alus ei l6ydy em.

Etsi paras kartta kursoin kohteelle.

Poista merkki.

Lokikirjamerkinta.

Seuraavan reittipisteen hyviksynti (jos valittu asetuksissa)

Kartan peittorajan piirto (karttajako) péélle / Pois

Autopilotti péélle / pois (NMEA-ulostulo)

Mahdolliset kartat pisteessd. "Automaatti”-tilassa GPS:n antamalle

pisteelle, pysyy ndkyvissd 20 sekuntia.

Ctrl+'S' tai F10:

Pienemmain mittakaavan kartta. ("Automaatti”-tilassa pysyy 20 sekuntia

pddlld jos litkutaan).

Ctrl+'T' tai F3:
Ctrl+'V' tai F11:
Ctrl+'X' tai -:
Ctrl+'Z' tai +:
Ctrl+' t'

Ctrl+' 2'

Ctrl+' 3'

Ctrl+' 4'

Seuranta péaélle / pois

Edellinen kartta

Zoomaa ulos

Zoom sisdidn

Normaali kirkkaus
"Pilvinen”-kirkkaus
”Auringonlasku/nousu”-kirkkaus
"Yo” -kirkkaus
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Asetukset

Yleista

Asetuksia voidaan muuttaa ominaisuudet-dialogissa johon pdistdidn pdamenusta tai
ponnahdusvalikosta. Oletushakemistojen asetukset ja karttojen skannaus/kalibrointi pitdd
tehda erilliselld ohjelmalla MapCal.

Naytto
Alus

— Pdivitysnopeus: Ruudun péivitysvili aluksen paikkatiedolle.
— Muoto: Aluksen piirtomuoto kartalla.
— Viri: Aluksen piirtovari.
- Koko: Aluksen piirtokoko.
— Tutkakehiit: Piirrettdvien tutkakehien lukumé&ara.
— Kehijako: piirrettdvien kehien jakovali.
— Nopeusmerkki: Aluksen eteen piirrettdvd nopeusmerkki sekunteina nykyiselld

nopeudella. Aseta arvoksi nolla jos jatetddn pois.

Kieli

— Kielitiedosto: Valitse tiedosto joka sisédltdd halutun kéyttokielen.
Nayttd

— Niyttopaneeli: Vasemmalla tai oikealla reunalla

- Koko rullalla: Kartan zoomaus rullahiiren rullalla p4illd / pois.

- Katso eteenpiin: Aseta suurin osa karttaa aluksen eteen p&illd / pois.

— Jatkuva nédyton péivitys: (levylle tallennetuissa tiedostoissa) Pdivitd ndytt6d kun karttaa
vedetddn hiirelld.
— Leved kursori: Kéytd paremmin nédkyvid hiiriosoittimia.

Kartta

— Kartan ennakkolataus: Parhaan kartan ennakkolatausaika sekunneissa
“automaatti”- tilassa.

- Hakuraja: Paikka kartan reunalla jossa hiiren kaksoisklikkaus hakee
paremman kartan.

— Uuden kartan koko: Zoomaus 100% tai edellisen kartan mukaan.
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Reitti
Seuraava reittipiste
— Ennakkolataus: Aika ennen reittipisteeseen saapumista, kun seuraava reittipiste
aktivoidaan.
— Max.Paluusuunta: Jos alus kulkee eri suuntaan kuin reitti, etdisyys jonka jalkeen reitti
uudelleen aktivoidaan jotta l6ydetddn uusi reitin alkupiste.
- Hyviksy uusi RP: Jos valittu, reittipaneeli muuttuu punaiseksi sithen saakka kun

reittipiste hyviksytdian. Hyviaksyntd ponnahdusvalikosta oikealla hiiripainikkeella, tai Ctrl +
"N” nd ppdimistolta.

Oletusarvot reitille
— Oletusnopeus: Oletusnopeus joka yhdistetddn uuteen reittipisteeseen.
— Sallittu reittipoikk. XTE: Maksimi sallittu poikkeama joka yhdistetddn uuteen
reittipisteeseen.
Reittinaytté
— Normaali viri: Viéri jolla normaalisti ndytetdén reittipisteet.
— Valittu véri: Valitun reittipisteen korostusviri.
- Koko: Reittipistemerkin koko.
— Viivan paksuus: Pisteitd yhdistdvén viivan paksuus.
— Naiytd reittip.tiedot: Naytd reittipisteen nimi kartalla.

Loki+Seuranta

Seurantatiheys
— Min.Aika: Madrittdd miten usein sijainti kirjoitetaan tallennustiedostoon.
— Min.etdisyys: Madrittad etdisyyden jonka jélkeen sijainti kirjoitetaan
tallennustiedostoon. Nolla (0) poistaa kdytosta.
— Kompassimuutos: Madrittdd suuntamuutoksen jonka jilkeen sijainti kirjoitetaan ,

tallennustiedostoon. Nolla (0) poistaa kdytosta.

Kaikkien ehtojen (jos ei poistettu kaytostd nollalla (0) ) tulee tdyttyd ennen kuin uusi merkita
kirjoitetaan seurantatiedostoon.

Seurantanayttd
- Viri: Seurantajéljen vari.
- Viivaleveys: Seurantaviivan leveys.
Lokikirja
— Automaattisyotto: Automaattiset tapahtumat jotka lisdtddn lokikirjaan
automaattisesti.
- Lokikirjatiedosto: Tiedostonimi ja polku johon lokikirjatiedot kirjoitetaan.
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Mittarit
Kaikuluotain
— Niytd syvyys: Jos NMEA-luotain liitetty, ndytetddnko syvyystiedot.
— Syvyyshiilytys: Jos syvyys on vihemmén kuin tdm4 raja, syvyysnayttopaneeli
hélyttda.
- Syvyyden muutos: Anturin asennussyvyys. Lisdtdan ndyttdmaan, jolloin ndyttad
syvyyttd veden pinnasta.
Tuulindytté
— Niytd tuulitiedot: Jos NMEA-tuulimittari liitetty, ndytetdanko tuulitiedot.
— Nuollen viiri: Tuulitiedon néyttdviri jolla tuulen suunta ja voimakkuus
ndytetaan.
0-1 M/s, pilkkuviiva
1-4 M/s, ohut viiva
4-8 M/s, 2 pistettd leved viiva
8-12 M/s, 3 pistettd leved viiva
>12 M/s, 4 pistettd leved viiva
Kompassinaytté
— Naytd kompassin tiedot: Jos NMEA-kompassi liitetty, ndytd kompassitiedot
Loki
— Niytéd nopeus ja matka: Lisdtyt tiedot ndytetddn GPS-paneelissa.
— Lokin katkaisu: Jos nopeus on vihemman, Loki, osamatka ja aika eivit péivity.

NMEA DR paivitys

Jos GPS-tieto katoaa ja NMEA-tieto nopeudesta, ja kompassisuunnasta sdilyy sen perusteella
lasketaan ohjelman toimesta laskennallinen paikkatieto kunnes GPS taas toimii.

Huomaa: Syvyys-, tuuli ja kompassinéytot vaativat NMEA-viestin laitteistosta muuten néytt6jd ei ndytetd. NMEA-lauseet DPT, MWV,
MWD, VWR, VHW, HDG luetaan.
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Com
NMEA yhteys
- PCPort: Com 1- 9. Yksi portti ldhetykseen, 3 vastaanottoon.
— Nopeus (BPS): Tiedonsiirtonopeus. NMEA-oletusnopeus on 4800.

Huomaa: SeaClear vastaanottaa tietoja kolmesta portista. NMEA lédpireititystd voidaan kéyttdd rajoittamaan edelleen ldhetettavia NMEA-
lauseita jolloin SeaClear toimii suodattavanasekoittajana NMEA-liikenteessd. Tai USB-GPS:44 voidaan kayttad paikkatietoihin
sarjaporttiin kytkettdavan autopilotin kanssa.

GPS-koordinaatiston asetus

GPS:n maakohtaisten kartta-asetusten valinta. Valitse listalta.

NMEA-Iapireititys

NMEA-lauseet jotka vastaanotetaan, ldhetetdin edelleen ulospdin. Varmistu ettd SeaClear:in
itsensd kehittdmii lauseita ei ldpireititetd. Lauseet ldhetetddn riippumatta siitd, onko "NMEA
ulos”-valinta paélld vai pois.

NMEA ulos

Kun reitti on aktivoitu ja "NMEA-ulos” on péill4, laskettu reittitieto ldhetetdan.

Lauseet: Valitse mitd lauseita l1dhetetddn autopilotille, tutkalle tai muulle
kytketylle NMEA-laitteelle. WPL & RTE ldhetetddn vain kun reitti aktivoidaan, kaikki muut
lauseet riippuen valitusta pdivitysvélista.
Jos "Tuo NMEA:sta” on valittu "Tiedosto” > "Reitti” tai "Tiedosto” > "Kiintopisteet”
valinnoilla tieto ldhetetddn riippumatta NMEA-ulos asetuksista.
Vastaanottajan sovitus: Miten kiintopisteiden nimet suodatetaan ennen ldhetysta.
”Isot kirjaimet” pitdisi toimia useimmissa NMEA-laitteissa. Jotka
lukevat NMEA-lauseita.
”+pienet kirjaimet” ldhettdd kaikki ASCIImerkit joiden koodi on
alle 128.
"Pida” ldhettdd kaikki merkit 8bittisend Windows ANSI standardin
mukaisena.
”"Numeerinen” lihettid vain kiintopisteen numerotunnuksen ja
sen pitdisi toimia jopa vanhempienkin NMEA-laitteiden kanssa.
Tama4 asetus vaikuttaa myos sithen mité ldhetetdédn reittejd karttapisteviennissda NMEA:lle ja
miten teksti tallennetaan "Waypoint+” ja G7ToWin viennissa.
”Nexus” ldhettdd Silva Nexus ja NX2 muodossa.
Piivitysnopeus: Miten usein NMEA-tieto ldhetetddn.
XTE-vahvistuskerroin: XTE-virhe voidaan vahvistaa tai vaimentaa ennen ldhetystd
autopilotille jotta saadaan parempi ohjaus ilman kiemurtelua. Arvo 100% tarkoittaa 1:1
vahvistusta.

NMEA-tunnus: NMEA-laitteen tunnus. Aina kaksi kirjainta. Normaalisti "EC” tai
” GP”

Sdilyti reittipisteen

tunnus: Kiintedt nimet reittipisteilld p&illd / pois. Voidaan tarvita

joidenkin NMEA-laitteiden kanssa, jolloin saadaan laite vaihtamaan reittipistettd ilman
kuittausta.
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Muuta

Aénivaroitus

- Aéni pailli: Kayttdd ddnitiedostoa, joka médritellddn .ini-tiedostossa,
varoitusddnend

Kaynnistys

— Jérjestelmiaika
GPS:sti: Kéytd GPS:44. Pdivittad tietokoneen kellon GPS:n antamasta ajasta
ohjelman kdynnistyessa.

— Lataa edelliset
kiintopisteet: Lataa kiintopisteet jotka olivat kdytdssd ohjelman edellisessa
ajossa.

— Lataaedellinen reitti: = Lataa reitin joka oli kdytdssd edellisessd ohjelman ajossa, vaikka
sitd ei olisi talletettukaan.

Y6-tila

— Valitse ndyton himmennyksen %-arvon eri pikavalinnoille (Pdiv4, pilvinen, ilta/aamu, y0).
Numeroarvo -95 ... 95 jossa 0 tarkoittaa ei himmennysta. Negatiivinen arvo kdantaa varit
ennen himmennysta.

— Piilota kidyttopaneeli: = Windowsin tyopoyta kokonaisuudessaan himmenee.

Kiintopisteet
— Oletusviri: Kiintopisteiden normaalivari.
— Valittujen viri: Kiintopisteiden korostusvri.
- Koko: Kiintopisteen koko kartalla.
— Niytd paikan tiedot: Néytd kiintopisteen nimi kartalla.

Kartan reuna

— Viri: Muuttaa kartan reunan véria.
— Suurin nédytettiva: Mika peittoalue ndytetddn. Jos 20, karttojen, skaalassa 1 — 20 x
nykyinen mittakaava, ndytetdan.
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Karttojen asennus

MapCal

Uusien karttojen asennus ja vanhojen sdddot hoidetaan ohjelmalla MapCal. Rasterikartta sisaltad
kuvan ja kalibrointitiedon jolla positio kuvassa muunnetaan maatieteelliseksi positioksi.
Minimissédén 2 kalibrointipistettd tarvitaan. Kalibroinnin tarkistamiseksi voidaan kayttaa
ruudukkoa kuvan péilld. Karttareuna jossa on kiyttokelpoinen kartta-alue voidaan luoda ja sitd
kdytetddn parhaan kartan automaattivalinnassa. Sekd ruudukko, ettd reunus piirretdédn kayttden
valittua karttaprojektiota.

PNG ja BMP-tiedostoissa kalibrointitieto pitd4 tallettaa erilliseen tiedostoon kun taas WCI,
BSB/KAP ja GEO/NOS tiedostoissa on sisddnupotettu kalibrointitieto.

Aikaisempi versio SeaClear:ista kdytt44 erilaista kalibrointitapaa joka voidaan muuttaa sopivaksi
nykyiseen muotoon.

OziExplorer ”.map”-tiedostot voidaan muuttaa WCI-muotoon joka siséltda kalibrointitiedon sekd
kuvadatan. Huomaa ettd ”.map”-tiedostoissa ei ole alkuperiistd mittakaavaa, mittakaava luodaan
metrien perusteella. Vain ”.map”-tiedostot jotka osoittavat olemassa olevaan kuvaan voidaan
konvertoida.

WinGPS-karttakalibraatiot ”.chi”-tiedostoista voidaan konvertoida. Koska kuvat ovat BMP-
muotoa, suoraan luettavissa SeaClear:illa, kalibrointitiedosto luodaan samaan hakemistoon kuin
missd ”.chi”-tiedosto sijaitsee. Konvertoinnin jilkeen kaikki tiedostot voidaan suoraan avata
kalibrointitietojen kanssa.

GMP-tiedostot (Meri-CD) voidaan konvertoida. Jos yhteensopiva ”.IN8”-tiedosto, jossa on
kalibrointitieto, on saatavilla se liitetian WCI-tiedostoon. Mittakaava pitdd syottdd, mutta jos
hakemiston kaikki tiedostot konvertoidaan kerralla se tarvitsee syottdd vain kerran. Loput
mittakaavat lasketaan sopiviksi.

MapCal voi my6s konvertoida usean tyyppisid kuvia WCI-muotoon kéytettdviksi SeaClear:issa.
BMP, PNG, TIF, JPG, PCX ja monta muuta tiedostomuotoa voidaan muuntaa. Huomaa, etti
SeaClear ei tue kaikkia néitd formaatteja suoraan vaan ne pitdd konvertoida MapCal-ohjelmalla
WCI-muotoon ennen kéyttdd. Jos kalibrointitieto on saatavilla se upotetaan syntyvdaan WCI-
tiedostoon. WCI-tiedostot voidaan muuttaa BMP-muotoon, mukaan lukien kalibrointitiedot, jotta
kuvia voidaan editoida. Editoidut kuvat voidaan sitten palauttaa takaisin WCI-muotoon
kalibrointitietoineen.

Automaattista latausta varten kootaan tiedot karttojen peittoalueista ja mittakaavoista. Tdima
tietokanta rakennetaan MapCal-ohjelmassa ja sitd tulee pdivittdd jos mitd tahansa
kalibrointitietoa muutetaan olemassa oleviin karttoihin, tai uusia karttoja lisdtdén. Karttojen
koordinaattijarjestelma tarkastetaan my®os.

Kartan asennusohje

Seuraavat toimenpiteet on tehtdvi asennettaessa kartta SeaClear:iin (BSB-karttojen asennus,

katso alempana).

1) Tee kartta kdyttdmalla skanneria tai kuvaruutukopiota. SeaClear tukee Fixed grid, Mercator,
Transverse Mercator, Polyconic, Lambert Conformal Conic, Sinusoidal, Orthographic and
Vertical Near-side Perspective projisoituja karttoja (suomennukset eri projektiosta jitetty
kaantamaittd tarkoituksella, oikeiden nimitysten varmistamiseksi).

Transverse Mercator-pohjaiset projektiot, kuten UTM ja GAUSS ovat my6s tuettuja. Useimmat
projektiot toimivat hyvin pienemmilla alueilla, kuten normaalisti navigoinnissa on kyse.
Useimmat poytdskannerit kdyvét. Variskanneri on mukava. Jos skannaat, tee muutamia
kokeita saadaksesi parhaan kontrastin ja varmistu ettd kartta on suorassa skanneriin ndhden.
Tiedoston pitdd olla viripalettimuodossa (maks. 256 virid) ja talletettu pakkaamattomana .
BMP tai .PNG tiedostona. PNG normaalisti tekee paljon pienempii tiedostoja, mutta on
hitaampi lataantumaan. BMP ei toimi y6-tiloissa, joten PNG on suositeltu tiedostomuoto, jos
tiedostoa ei muunneta WCI-muotoon. Useampia skannauksia tai kuvaruutukopioita voidaan
liitt44 yhteen. Tarkkuus 100 — 250 DPI on suositeltava. Koko 2000 x 2000 pikselid kayttdd 4Mb
muistia ladattuna, kun taas levytilan kaytto riippuu kéytetystd tallennusmuodosta. PNG-
tiedostoissa maksimissaan 256 virid voidaan kdyttds, mutta koska tiedostot pakataan ei
varimadralla ole suurta eroa.

Tallenna tiedosto SeaClear:in karttahakemistoon (charts).
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6)

7)

8)
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Kéynnistd MapCal_2.exe. Jos WCI-muotoa kiytetddn kayta Tools->Convert->Single file WCI-
muunnokseen ennen kalibrointia.

Avaa tiedostosi, alkuperdinen tai WCI, File-> Open Image :lla.

Kéytd Edit-> Chart Information ja anna kartalle nimi, mittakaava, projektio ja paikkatiedot.
Muu on valinnaista tietoa. (Tdm4 dialogi avautuu automaattisesti kun avataan kalibroimaton
kartta). Jos leveys tai pituuspiirrin siirtoa kdytetddn, annetut arvot ohittavat kartan
paikkatietoasetukset. Leveyspiiri 0 on nolla useimmille kartoille, kun taas pituuspiiri 0,
keskimeridiaani Transverse Mercator, Polyconic, Lambert ja Sinusoidal projektiossa, on
ennakolta médritelty pituuspiiri 1dhelld karttaa. Jos et ole varma jédtd arvoon 0, jolloin MapCal
valitsee sopivimman keskimeridiaanin.

Jos Lambert projektio on valittu eteldinen ja pohjoinen standardi paralleeli kysytddn. Aseta 0
jos se ei ole tiedossa, jolloin MapCal valitsee oletuksen.

Ortographic ja Vertical Near-side Perspective parametrit pitdd tiyttdd oikein, oletukset johtavat
yleensd vadriin parametreihin.

Prioriteettia kdytetddn automaattilatauksessa jossa 1 on korkein prioriteetti. Prioriteetti 10
tarkoittaa samaa kuin mittakaavan puolitus, siten 25000 mittakaavankartta prioriteetilla 10 on
sama kuin 50000 mittakaavan kartta prioriteetilla 1.

Jos haluat ettei kartta lataudu automaattisesti, mutta nikyy automaattilatauslistalla, kdyta
suurta prioriteettinumeroa.

Laita vdhintddn 2 merkkia kartalle tunnettuihin positioihin, kauaksi toisistaan vastakkaisiin
kulmiin, ja anna positioille koordinaattitiedot. Lukuun ottamatta Fixed grid ja mercator-
projektioita, vdhintdin 3 positiota on normaalisti tarpeen. Siirrd hiiri position kohdalle ja
klikkaa oikealla kalibraatiopisteen lisdidmiseksi. Hienosdddi, jos tarpeen, paneelin
nuolindppdimilld. Kirjoita oikea leveys / pituustieto.

Paina "Activate changes” (kohdat 2 ja 3 voidaan tehdd kummassa tahansa jarjestyksessd). Nyt
ruudukko ndkyy valitulla rasterilla. Ruudukon vérinvaihto tapahtuu klikkaamalla vérineliota.
Jos ruudukko sopii tarkasti on homma tehty.

Jos ruudukko ei sovi, valitse joko piste "Calibration points”-listalta ja siirrd sitd N/S ja E/W
nuolilla tarpeen mukaan, tai lisdé uusi piste. Siihen tulee koordinaatit valmiiksi, joten siirrd
vain sitd nuolilla tai raahaa hiirelld. Painamalla "Activate changes” ndyttda miten se suhtautuu
ruudukkoon. Tdma4 tekee suunnilleen saman kuin vanha viistosiirto, paitsi ettd "Activate
changes” pitdd painaa. Kalibroinnin pitéd4 olla oikea ennen kohtaa 7 koska kartan reunan
koordinaatit tallennetaan téssa.

Klikkaa reunakaistaa kartan reunan luomiseksi. Reunapisteet lisdtddn samaan tapaa kuin
kalibraatiopisteetkin oikealla hiirinapilla. Tai klikkaa ” Set border to image”, jolloin kartalle
tulee 5 pisteen marginaali. Tdim3& tehdddn automaattisesti talletuksen aikana jos reunaa ei
luoda manuaalisesti.

Talleta kalibraatio File->Save Calibration.

Tamadn pitdisi olla kaikki miti tarvitaan. Uusien karttojen kalibroinnin jédlkeen, olemassa olevien
karttojen kalibroinnin muutosten jilkeen, esikalibroitujen BSB/KAP karttojen lisdyksen jdlkeen,
tai kun karttatiedostojen polku on muuttunut on tarpeen pdivittdd (update) tai luoda uudelleen
(recreate) automaattilatauslista SeaClear:ille.
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MapCal opas

MapCal-ohjelmaan ei ole olemassa suomenkielisti kielitiedostoa, joten selvyyden vuoksi
valikkojen tekstit on jatetty alkuperéiskielelle ja vain toimintojen kuvaukset on kddnnetty.

File valikko
— Open Image: Avaa minkd tahansa kuvatiedoston. Jos kalibrointidata on
saatavilla, se ladataan.
— Open From List: Avaa tiedoston nimen perusteella. Automaattilatauslistaa
kaytetddn hakuperusteena.
- Save Calibration: Tallentaa kalibrointitiedot (jos niitéd on).
Edit valikko
— Chart Information: Avaa kartan yleistietojen syottodialogi. Mittakaava, projektio, ja

karttapositio ovat pakollisia tietoja. Muut ovat valinnaisia. Katso kohtaa 4 edelld. Avautuu
automaattisesti uusille kartoille.

Tools valikko

Convert valikko

Convert-valikko on kuvatiedostojen formaatista toiseen muuntamista varten.

— Current to WCI: Muuntaa ladatun kuvan WCI-muotoon kalibraatiotietoineen.

— Current WCI to BMP: Muuntaa ladatun WCI-tiedoston BMP-muotoon
kalibraatiotietoineen

- Single file to WCI:  Suurin osa kuvatiedostoja voidaan muuntaa WCI-muotoon,
mukaan lukien muodot joita ei voi avata MapCal tai SeaClear ohjelmilla. Tiedostot voivat
olla kalibroimattomia.

- Images in Dir to WCI:Muuntaa kaikki kuvatiedostot hakemistossa. Tiedostot voivat olla
kalibroimattomia, koska kalibrointeja voi muuttaa WCI-tiedostoissa.

— MAPinDirto WCI: Muuntaa kaikki OziExplorer MAP ja kuvatiedostot kalibroiduiksi
WCI- tiedostoiksi.

Import Cal valikko

Import Cal valikko on kalibrointitietojen tuontia varten.

— 0ld SeaClear Calibration: Tuo kaikki l6ytyvéat kalibroinnit. Tiedostopolut pitda
asettaa ja "seachart.dir”-tiedosto pitdi olla oletushakemistossa. Olemassa olevat uudet
kalibraatiotiedot ylikirjoitetaan.

— CHI Calibrations: Tuo kaikki kalibrointitiedot WinGPS-muodon
”.chi”-tiedostoista.

Autoload List valikko
Autoload List valikko on SCAINDEX.BIN tiedoston pdiivitystd varten.

— Scan for New Charts:  Etsii uusia karttoja karttahakemistosta.

- Update: Etsii muuttuneita ja uusia kalibrointitietoja karttahakemistosta
Kaikki kartat joita ei l6ydetd jatetddn sikseen (esim. jos kartat ovat CD:114 ja CD ei ole
asemassa).

— Recreate: Poistaa SCAINDEX.BIN ja luo sen uudelleen kdyden l4pi kaikki

tiedostot tiedostopolussa. Vain 16ydetyt kartat lisdtdéan.
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Maintenance valikko
— Remove Unused Calibrations: = Poistaa kaikki kdyttamattomaét kalibroinnit kun tiedostot
joissa kalibrointi ei ole upotettuna , poistetaan.
Set Directories
Set Directories kdytetddn kaikkien tiedostopolkujen asetukseen MapCal ja SeaClear ohjelmia
varten. Toiminto péivittdd SEACLEAR_2.INI-tiedoston.
<<

Piilottaa ndyttopaneelin jolloin tydskentelyalue saadaan suuremmaksi. Paineli tulee takaisin
kuljettamalla hiiriosoitin vasemman reunan yli.
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Esikalibroitujen karttojen asennus

SeaClear:issa on valmiina tuki normaalille BSB/KAP ja GEO/NOS tiedostomuodolle. Mitddn
muunnokisia ei tarvita. Jotta kartat ndkyvit ja toimivat automaattilatauksessa ne pitdi
rekister6idd. Rekister6iméattomat, mutta kalibroidut tiedostot voidaan avata SeaClear:issa
paavalikosta "Tiedosto”-> "Kartta”->"Muut kartat”.

BSB-karttojen asennus

BSB/KAP-tiedostomuoto on lisensoitu Maptech:ille. BSB/KAP versiot 1- 3 ovat tuettuja.
Projektiot Mercator, Transversal Mercator, Polyconic, Lambert Conformal Conic, Sinusoidal ja
Orthographic ovat tuettuja. Karttoja on saatavissa useimmille maapallon alueille Maptech:ilts,
NDI:1téd ja monista muista ldhteistd. Kartta itsessddn on KAP-tiedostossa kun taas BSB-tiedosto
sisdltda tiedot peittoalueesta ja muusta vastaavasta. Koska SeaClear pitédd tiedostoa omista
kartoistaan BSB-tiedostoja ei tarvita.

Ennen BSB/KAP karttojen kdytto4 ne on rekisterditdva: Kadynnistd MapCal ja valitse
pddvalikosta "Tools-> Autoload list-> Scan for New Charts". KAP-tiedostot skannataan ja tiedot
nimestd, peittoalueesta ja muusta siirretddn SeaClear:in automaattilataustiedostoon.

GEO / NOS-karttojen asennus

Projektiot Mercator, Transversal Mercator, Polyconic, Lambert Conformal, Sinusoidal ja
Orthographic ovat tuettuja. Kartta on NOS-tiedostossa kun taas GEO-tiedosto sisdltdd
kalibrointitietoja peittoalueesta ja vastaavasta. Molemmat tiedostot GEO ja NOS tarvitaan ja
niiden pitd4 olla samassa hakemistossa.

Ennen GEO / NOS karttojen kdyttéd ne on rekisterditdva: Kdynnistd MapCal ja valitse
pddvalikosta "Tools-> Autoload list-> Scan for New Charts". Varmistu ettd kaikki GEO / NOS
tiedostot ovat karttahakemistossa. GEO-tiedostot skannataan ja tiedot nimestd, peittoalueesta
ja muusta siirretddn SeaClear:in automaattilataustiedostoon.

WClI-karttojen asennus

Kéynnistd MapCal ja varmista ettd kaikki WCI-tiedostot ovat oikein kalibroituja ja
karttahakemistossa. Valitse pddvalikosta "Tools-> Autoload list-> Scan for New Charts". WCI-
tiedostot skannataan ja tiedot nimestd, peittoalueesta ja muusta siirretddn SeaClear:in
automaattilataustiedostoon.

Koska WCI, KAP ja NOS-tiedostot ovat levypohjaisia luku CD-levyltd aiheuttaa hitaan
toiminnan. Siksi kopiointi koneen kovalevylle on suositeltavaa.
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SeaClear asennus kovalevylle

Jos asennat ohjelmiston .ZIP tiedostosta, luo padhakemisto ja pura sithen pakkauksen sisdlto.
Alihakemistot kartoille, reiteille, kiintopisteille ja seurannalle tarvitaan ja ne on asetettava .INI-
tiedostoon. Oletushakemistoja ovat "CHARTS", "ROUTES", "TRACES" ja"WAYPTS"
pddhakemiston alla.

Oletusrakenne on seuraava:

<Pddhakemisto>:
SeaClear_2.Exe
MapCal_2.Exe
Datums2.Ini
<Pddhakemisto >\Charts:
World.WCI
Med.WCI
USA.WCI
Sweden.WCI
<Pddhakemisto >\Routes:
(laita reittitiedostot tanne)
<Pddhakemisto >\Traces:
(Seuranta tallettuu tanne)
<Péddhakemisto >\Waypts:
(Laita kiintopistetiedostot tdnne)

Lisdksi SCAINDEX.BIN ja SEACLEAR_2.INI luodaan automaattisesti.

SeaClear:in ajo CD:Ita

SeaClear:ia voidaan ajaa suoraan CD:1td, mutta koska CD on vain luettavissa oleva media,
mitdén ei voi tallettaa. SEACLEAR_2.INI-tiedosto pitdd oletuksena olla samassa hakemistossa
kuin SeaClear ohjelmakin joten on suositeltavaa ettd tiedostot pidetdan kovalevylld. Huomaa
ettd levymapatut tiedostomuodot latautuvat hitaasti CD:1t4.

Kuitenkin, koska kartat ovat paljon tallennustilaa vaativia, SeaClear:in ajaminen kovalevyltd,
mutta karttojen pitdminen CD:11d on mahdollista. Kopioi kaikki, paitsi karttatiedostot
kovalevylle. Varmistu ettd kaikki tiedostomédritteet sallivat luku / kirjoitusoperaatiot. Toisin
sanoen poista tiedostojen ominaisuuksista "Vain luku”-méérite. Luo "Traces", "Routes" ja
"Waypts" hakemistot. Jos sait SeaClear:in CD:114 helpon tapa on kopioida kaikki kovalevylle ja
poistaa sitten "charts”-hakemisto. Kéytd MapCal-ohjelmaa tiedostopolkujen asetukseen.
Vaihtoehtoisesti kayttdmalld komentorivilld liitettd /I xxxx”, jossa xxxx on ".INI”-tiedoston
polku ja nimi, voidaan kakki tiedostot pitdd CD:1l4 paitis INI-tiedosto.

Useampien karttahakemistojen kaytto

Koska CD on melko hidas, osa kartoista voi olla kovalevylla toisten taas ollessa CD:114.
Kayttamalla DOS:in mukaista hakupolkumaaritetté:

"Chart Dir=C:\SEACLEAR\CHARTS\;D:\MYCHARTS\;D:\MOREMAPS\"

Kaikki kartat jotka 16ytyvat hakemistoista C:\SEACLEAR\CHARTS, D:\MYCHARTS ja
D:\MOREMAPS ohjelman kdynnistyessd nikyvét kartanlatausdialogissa. Karttoja jotka eivét ole
hakupolun varrella voidaan mydos kayttda jos tdydellinen nimi asetetaan asennuksen aikana
MapCal-ohjelmassa.

Asennuksen purkaminen

Kaikki asennetut ja luodut tiedostot ovat SeaClear-hakemistopuussa. Mitdédn tiedostoja ei
luoda padhakemiston ulkopuolelle. SeaClear:in poistoon riittdd kun poistat SeaClear:in
pddhakemiston ja kaikki pikakuvakkeet. Jos asensit SeaClear:in tdysasennusversiona, kaytd
Windowsin ohjauspaneelin "Liséd4 / poista sovellus”-valintaa.
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tietoja

Tietokone

GPS:

Pc jossa kiyttojarjestelmédnd on Windows XP/2000/NT tai 95/98/ME tarvitaan. Erdét rajoitukset
95/98/ME-kéyttojarjestelmissa tekevdt XP/2000/NT kadyttdjdrjestelmistd paremman valinnan
jolloin useita pienid ongelmia poistuu ja voidaan kéayttda paljon suurempia karttoja ilman
ongelmia.

(SeaClear ja MapCal toimivat myd6s Linuxin alla Wine:n kautta ajettuna, joskin sarjaportin
alustuksessa ilmenee ongelmia (SeaClear) ja siksi systeemi on kdyttokelpoinen ldhinna
reittisuunnitteluun yms. "kotitdihin” kunnes ongelma mahdollisesti poistuu uusien versioiden
my6td Suom.Huom.)

800x600 naytto riittdd, joskin 1024x768 on suositeltava jotta kaikki ndyttopaneelin tiedot
mahtuvat nikyviin.

Hiiri. Rullahiiri on suositeltava zoomauksen helppouden takia.
1 vapaa sarjaportti GPS:44 varten.
Pentium+ tai vastaava prosessori.

Minimissdin 32Mb RAM. 64Mb (riippuen kayttojarjestelmistd) on suositeltava ja nopeuttaa
karttojen latausta. (toimii jopa P90/25Mb/Win98 koneessa kohtuullisesti. Suom. Huom.)

PNG-tiedostot ovat hitaampia ja tarvitsevat enemman muistia lataantumiseen, Pentium ka
64MB muistia on silloin suositeltavaa.

10 - 2222 Mb vapaata kovalevytilaa (4Mb SeaClear:ille ja 10k — 10 Mb / kartta). Jokainen kartta
voi olla melko suuri tiedosto. Jos windowsin nédyttéasetuksissa on méiritelty enemmaén kuin
256 vidrid generoidut bittikartat kiyttaviat enemméan muistia ja hidastavat jarjestelmad. Siksi on
suositeltavaa ettd Windows on aseteltu kdyttdmé&idn 256 vérid vaikka néyttokortti sallisi
useamman varin kdytén. Tdma on erityisen tdrkedd 95/98/ME-kayttojdrjestelmissd ja koskee
myos PNG-tiedostoja koska ne ovat ladattuina paljon suurempia kuin levylla.

Levymapatuilla kartoilla (WCI&KAP) vain nikyva osa karttaa on ladattu ja Windowsin asetukset
eivét ole niin vaikuttavia.

Koska kaikilla Windows:eilla on tietty 32k rajoitus kuvakoolla, maksimi karttakoko on 32k x 32 k
ja se on myos maksimi zoomauskoko, joten vain kartat joiden koko on vahemmaén kuin 8k x 8k
pikselid zoomaantuvat 400%:iin.

Isojen karttojen tulostus saattaa vaatia Windows NT/2000 tai paremman kayttojarjestelmén.

n liittdminen

GPS:n pitdd pystyd ldhettdmaan NMEA 0183 RMC, RMA tai GGA / GLL & VTG sanomia. Jos GPS
voidaan asettaa eri NMEA-versiolle, valitse NMEA 2.0. Aiemmat versiot 0183:sta voivat toimia,
mutta eivit ole kunnolla testattuja.

Tutki GPS:n ohjekirjaa kytkentdjen suorittamisesta PC:lle. Koska NMEA méarittda sarjaportin
asetukset ei muuta muutosta yleensd tarvita kuin PC:n sarjaporttinumeron tarkistus. GPS
kytketddn RX ja GND-pinneihin PC:ssa.

9-pinnisen liittimen, useimmiten kéytetty, Pin 2=Rx, 3=Tx 5=Gnd. 25-pinnisessi liittimessd
vastaavat ovat Pin 2=Tx, 3=Rx ja 7=Gnd
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NMEA-kuuntelijan lisaaminen

NMEA-kuuntelija, kuten autopilotti, pitdd olla laite joka hyvdksyy NMEA APA, APB, RMB, BOD,
BWC, WPL tai RTE lauseet.

Tutki ohjekirjaa kytkent6jen suorittamisesta PC:lle. Koska NMEA méarittd4 sarjaportin
asetukset ei muuta muutosta yleensa tarvita kuin PC:n sarjaporttinumeron tarkistus.

Portti on sama johon GPS kytketddn. Kuuntelija kdyttdd TX ja Gnd pinnejd. Koska molemmat,
suunta ja XTE-virhe ldhetetdédn, autopilotti voi ohjata aluksen hyvin ldhelle aktiivia reittia.
Vastaanotetut NMEA-viestit voidaan myos liittd4 ulostuloon.

Laskut ja tarkkuus

Suunta ja etdisyyslaskut tehdddn kiyttden suoraviivaista laskutapaa. feng. rumbiinel. Kaikki laskut
tehdddn tuplatarkkudella virheiden vihentdmiseksi. Suurilla etdisyyksilld ndma laskut ovat
epatarkkoja. Normaalissa, kuten saaristonavigoinnissa, virheet eivit ole huomattavia koska
GPS:n ja karttojen tiedot ovat epatarkempia. SeaClear ei toimi pdivimé&drirajan
ylittdvienkarttojen kanssa (180° E/W)

WCI tiedostomuoto

Alkuperdinen tiedostomuoto, WCI (World Calibrated Image) on tuettu. Se sallii
levymappauksen ja kalibrointitiedot voidaan luoda olemassa olevista kuvatiedostoista. Se
pakkaantuu yleensi hyvin ja sallii uudelleenkalibroinnin. WCI on palettimuotoinen
tiedostomuoto joka sallii 256 vérid, maksimikoon 32767 x 32767 pikselid ja 1Gb tiedostokoon.
MapCal:ia voidaan kéyttdd WCI-tiedostojen luontiin. Vain palettimuotoisia tiedostoja voidaan
muuntaa. Muoto sopii suurille kartoille joissa ei ole paljoa vérejd. Paras tulos saadaan kartoilla
joissa on vdhemmaén kuin 64 virid ja suuria yhtendisid vérialueita.

Levymappaus

Levymappaus jota kaytetdan WCI, BSB/KAP ja GEO/NOS- tiedostoissa sallii suurien
tiedostojen kayton koska vain kulloinkin nédytettdva osa karttaa ladataan levytiedostosta.
Tiedostot joiden pakkaamaton koko on yli 150Mb on testattu toimivan laitteistoissa joissa
muistim#&rd on hyvin rajoitettu. Jos mahdollista levymapatut tiedostot pitdisi tallettaa muualle
kuin CD:lle koska joka kerta kun nédytto paivitetddn, tiedosto luetaan uuden kerran. Samasta
syystd pirstoutunut kovalevytila aiheuttaa hitaan toiminnan. Zoomatessa pieni sivusiirto
saattaa olla huomattavissa koska kuva pitdd kohdistaa alkuperdisiin tietoihin ja jokainen juova
muuttuu koska korvataan uudella paikalla.

Karttojen tiedostomuodot

SeaClear on suunniteltu hydodyntdméan levymapattujen tiedostomuotojen hyddyt. Kuitenkin,
PNG ja BPM-muotoja voidaan silti kayttdd. Koska kartat tarvitsevat kalibrointitiedot ne
tallennetaan erilliseen tiedostoon samassa hakemistossa kuin PNG ja BMP-tiedostot ovat, kun
taas KAP ja WCI-muodoissa on tiedostoon upotetut kalibrointitiedot.

BMP-tiedostot ovat hyvin suuria ja niité ei voi asettaa yo-tilaan (himment43). PNG normaalisti
pakkautuu hyvin, joten tiedostokoko levylld jad pieneksi.

Kalibroidut BMP ja PNG-tiedostot voidaan muuntaa WCI-muotoon. MapCal osaa my0s
muuntaa monta muuta tiedostomuotoa WCI-muotoon, kaytettdviksi SeaClear:issa.

Eranto

SeaClear laskee automaattisesti erannon kullekin paikalle. Laskenta perustuu aina
viimeisimpé&én saatavilla olevaan tietoon parhaan tuloksen saavuttamiseksi. Sisdisen
laskennan peruuttamiseksi ja GPS:n arvojen kayttdmiseksi katso SeaClear_2.ini-tiedoston
asetuksia.
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G7ToWin ohjelman kaytto GPS:n kanssa

SeaClear voi kommunikoida GPS:n kanssa erillisen apuohjelman G7ToWin.exe kautta.
Huomaa ettd jotkin GPS-mallit vaativat protokollan muutoksen toimiakseen G7ToWin kanssa
koska kaikki toimintatavat eivit ole kdytettdvissa NMEA-tilassa. G7ToWin Version A.00.140
kéaytettiin testaukseen ja luultavimmin uudemmat versiotkin toimivat.

1) Asenna kopioi G7ToWin.exe:std samaan hakemistoon kuin SeaClear_2.exe:kin

2) Kaynnistd G7ToWin ja aseta se toimimaan GPS:n kanssa. Testaa toiminta, talleta asetukset
jalopeta.

3) Kaynnistd SeaClear. Nyt GPS-valikko SeaClear:issa on aktivoitu. Kiintopisteet ja reitit
voidaan ldhettdd ja vastaanottaa GPS:lle/:lta.

Kun SeaClear ldhettdd dataa GPS:lle se ensin tekee tilapdistiedoston G7T-muodossa ja sitten
kdynnistdd G7ToWin-ohjelman komentorivitiedoilla tilapdistiedostosta. Tietojen haussa
GPS:std G7ToWin ensin kdynnistetddn jotta tieto saadaan g7t-tiedostoon, sitten SeaClear
lukee tiedoston. Seurantatiedoille tiedosto jonka nimi on GPS:std 16ytyva viimeinen
seurantatiedon pdivamaédrd, luodaan. Tiedosto on esimerkiksi "20030603-g7t (1).trc.
Viliaikaisen tiedoston nimi on aina nimeltdan $$g7t0$$.g7t joka luodaan SeaClear:in
paddhakemistoon.

Miké tahansa G7ToWin-virhesanoma, kuten "Error More than 30 points - Rest are skipped"
ei vility SeaClear:ille. Tietojen tuonnin aikana, jos mitddn tuotavaa ei ole, tuontivirhe
generoidaan.

SeaClear olettaa ettd kaikki pisteet 1dhetyksessé tai vastaanotossa ovat WGS-84-muotoa,
varmistu siis ettd sekd G7ToWin ja GPS on asetettu tdhdn muotoon.

G7ToWin DDD, DMM ja DMS paikkatietomuodot ovat tuettuja vastaanotossa. Lahetyksessd
muoto on aina DMM-muodossa. "V-ottajan sovitus”-kohdassa SeaClear:in asetuksissa
madrdtddn miten teksti ldhetetddn GPS:lle. Varmistu ettd asetus sopii kidyttdmadsi GPS:dén.

G7ToWin ja Waypoint+ tiedostotuki

G7ToWin ja Waypoint+ tekstitiedostot ovat tuettuja sekd viennissé ettd tuonnissa.
Tiedostonimen laajennetta kiytetdan tiedostomuodon tunnistukseen. Tiedostot jotka on tehty
G7ToWin-ohjelmassa pitédd olla nimetty ”.g7t”-péitteelld. Waypoint+ tiedostot tulee olla
tekstimuodossa ja nimeltddn ”.txt” paatteisia.

Yo-tila

SeaClear voi sdiatda nayton kirkkautta jos kartta on PNG,WCI tai KAP-muodossa. PNG-
muodossa tdméi tehddin latauksen yhteydessd ennen kuin kartta niytetdan. WCI ja KAP-
muodoissa toiminto muuttaa kaytettdavad viripalettia ja uudelleenlataus ei ole tarpeen.

Neljé eri tasoa voidaan valita normaali, pilvinen, ilta/aamu ja y6. Normaali-tila on tavallinen
kirkkaus ilman muutoksia. Muut kolme asetellaan asetuksissa halutulle himmennysprosentille
jossa 0 tarkoittaa ei muutosta, negatiivinen numero kdantad kaikki virit ennen himmennystd.
Windowsin tydpdyddn himmennys voidaan valita erikseen asetuksista.

Kayttokieli

Kayttokielen valinta

Asetuksissa voidaan valita kielitiedoston nimi ja polku. Suurin osa tekstistd on kddnnetty.
Valinta jad voimaan kunnes sitd muutetaan.
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Kayttokielitiedoston luonti

1) Kéyta English_2.Ing-tiedostoa pohjana ja kopioi se omaan kielitiedostoon (omalle nimelle)
2) Kaytd tekstieditoria, kuten Notepad, tiedoston avaamiseen. Kaikilla tekstijonoilla on muoto:
" _Brm.XTELabel.Hint=Crosstrack Error' jossa vasemmalla on avain, 414 muuta sit3, ja
oikealla ndkyva teksti. Kdy l4pi kaikki tekstit ja muuta tekstit.
Menuissa kirjainta edeltdvi ”"&”- merkki alleviivaa kirjaimen ja tekee siitd
pikavalintakirjaimen.
Jos teksti alkaa tai loppuu tyhjddn lyontiin aloita ja lopeta merkkijono ”-merkilld esim.
_Form.TX_MESSAGES.Lines.31="is not saved! Save?".
Otsikko ”[Txt_2]” pitdd olla ensimmaiinen rivi tiedostossa.
Tallenna tiedosto nimipéétteelld ”.Ing”.
3) Valitse edelld luomasi tiedosto.
4) Tarkista ettd kaikki muuntamasi tekstit mahtuvat niille varattuihin tiloihin !

Ole hyvi ja ldhetd luomasi tekstitiedostot osoitteeseen seaclear@sping.com niin etti ne
voidaan liittd3 ohjelmajakeluun.

Huomaa: Vain ANSI-kirjaimistoa voidaan kayttaa

Huomaa: Uusi tiedostopohja voidaan luoda asetuksissa asettamalla nimen eteen "save:” (esim. "save:C:\sc\lang.Ing”) . Lataamisen
sijasta uusi tiedosto luodaan . Kaikki voimassaolevat muutokset huomioidaan.

Geodeettiset kartta-asetukset

Yhdistetty GPS pitdd sditdd lahettdmadn paikkatietoa kdyttden WGS 1984-muotoa. Jos néin ei
ole, valitse oikea muoto asetusten valinnasta. Paikkatieto kddnnetdin silloin WGS-84 muotoon.
Kaikki sisdiset laskennat tehddan tdssd muodossa.

Kun muita kuin WGS-84-karttoja kédytetddn kartta kalibroidaan normaalisti sdatamalla
ruudukko kartan muotoon. Valittu karttamuoto otetaan kdytt66n muunnettaessa kartan
paikkoja WGS-84.muotoon SeaClear:issa. Kaikki paikkatieto muunnetaan, alus, kiintopisteet
paikat ja seuranta.

Kaikki karttamuodot on talletettu tiedostoon Datums2.INI. Koska esikalibroidut kartat voivat
viitata samoihin muotoihin eri nimill, alias-osa nimille on kdyttssd. Aliaksen voi lisdta
lisaamalla rivin "Alternate datum name=SeaClear name" [DatumsAliases]-osassa, jossa
"SeaClear name" on nimi joka on

[Datums]-osassa. Automaattilatauslistan luonnin aikana kartan muoto varmistetaan ja
esikalibroidut kartat jotka kayttdvit eri muotonimid avaavat dialogin jossa kysytdan mikd on
vastaava SeaClear-nimi. Yhteys talletetaan [DatumAliases]-osaan.

Huomaa: GPS-jdrjestelmi perustuu WGS-84 geodeettiseen jdrjestelmddn ja muunnokset muihin jarjestelmiin eivét ole tarkkoja.
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Karttaprojektiot

SeaClear tukee Mercator, Transversal Mercator, Polyconic, Lambert Conformal Conic,
Sinusoidal, Orthographic, Vertical Near-side Perspective and Fixed Grid projektioita. Useat
Projektiot jotka pohjaavat Transverse Mercator:iin kuten UTM ja Gauss Kriiger ovat myos
tuettuja.

Projektiotyyppi valitaan kartan asennuksen aikana. Jos keskimeridiaani (Lon0) on tuntematon
Transversal Projektiossa, kartan keskustan kaytt6 toimii normaalisti hyvin. Latitudi (Lat0) on
useimmiten muuta kuin 0. Lambert-projektiossa eteldinen ja pohjoinen standardiparalleeli
pitéd tietdd. Jos projektiota muutetaan kartan kalibrointi pitda tarkistaa. Muutokset Mercator,
Transversal Mercator, Polyconic, Lambert Conformal Conic, Sinusoidal ja Orthographic
projektioissa voidaan lisdtd Datups2.INI-tiedostoon.

[Projections]-osaa kdytetddn kayttdjan projektioita varten.

Name=Base, Lat0, Lon0, LatS, LatN jossa name on nimi joka néytetdan pudotusvalikon listalla.
Base arvo on 1 Mercator:ille , 2 Transverse Mercator:ille, 3 Lambert:ille, 4 Polyconic:ille, 5
Sinusoidal:ille ja 6 Orthographic:ille.

Lat0 on peruslatitudi, Lon0 on keskimeridiaani. Kaytdssd pudotusvalikko vaihtuu
alkuperiiseen projektioon ja Lat0 ja Lon0 korvataan annetuilla arvoilla.

SeaClear_2.INI Tiedoston asetukset

Useimmat asetukset pdivittyvit SeaClear:in kautta. Kuitenkin joitakin asetuksia voidaan
muuttaa tekstieditorilla.

Muutoskelpoiset INI-tiedoston asetukset

[Program State] -osa

[Program State] pdivittyy SeaClear:in kautta ja sitd ei pitdisi muuttaa, paitsi lokin ja ajan
resetoimiseksi. SeaClear ei saa olla kiynnissd muutoshetkella.

Lokin nollaus tapahtuu poistamalla avain "Total Distance=XXXX"

Ajan nollaus tapahtuu poistamalla avain "Time Counter=XXXX"

[Program Setup] -osa

; Kdytd karttanumeroita nimessd. BSB/KAP ja GEP/NOS-tiedostoissa karttanumero
; liitetddn nimeen Kayttokelpoista jos jos kartoilla on sama nimi, mutta eri numero.
; Oletus on 0=pois, 1=pdilla. Asetusta kayttdd MapCal.

; Jos muutetaan pitdd automaattilatauslista padivittaa.

Autoload list.

Use Chart Numbers=0

;Miten SeaClear kisittelee NMEA-tarkistussummia. Kdynnistd SeaClear uudelleen

; jos muutat arvoja.

NMEA CheckSum=1

; 0= pakota kdyttdmaédn tarkistetta, tarkistussummatonta lausetta ei hyvaksyta.

; 1= Hyvdksy summattomat lauseet, kdytd tarkistussummaa jos se on saatavilla.

; 2= Al4 tarkista NMEA tarkistussummaa.

; Oletusvaroitusddnitiedosto (.wav)

;Jos polkua ei anneta oletetaan tiedoston olevan Windows-hakemistossa.
Sound1=DING.WAV

; Korvaa 44ni toisella .wav-tiedostolla:

Sound XTE R=tiedostonimi ; XTE-oikealle varoitus

Sound XTE L=tiedostonimi ; XTE-vasemmalle varoitus

Sound NMEA=tiedostonimi ; NMEA-varoitusdiani

Sound Dpt=tiedostonimi ; Syvyysvaroitusdani;
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; Kéytd erantoa GPS:sta.

MagErr Calc=0

;Voit tallentaa valitut NMEA-lauseet tiedostoon. Miki tahansa NMEA-lause voidaan
;tallentaa vaikka SeaClear ei kiyttdisikddn sita.
NMEA_CAPTFILE=C:\NMEACAPT.TXT ; tallennustiedoston nimi
NMEA_CAPTMSG=RMC,GGA,VTG,DBT ; Tallennettavat lauseet. Kdyta * jos haluat
;tallentaa kaikki lauseet.

; Voit simuloida GPS-dataa lukemalla sitd tiedostosta. NMEA-sisddanmenoa ei tarvita.
NMEA_SIMUL=C:\NMEAINP1.TXT

;WCI/KAP/NOS levypuskurin koon muutos. Oletus on 1/8 tietokoneen muistista tai
;maksimissaan 16Mb. Arvo annetaan kilobitteina (kb).

;normaalisti ei tarvitse muuttaa.

Diskmap Buffer=16384

;Ladatun WCI-kuvan koko kun se on ladattu muistiin. Oletus on asettaa se samaksi
;kuin Diskmap Buffer. Asetus 0 nopeuttaa ensimmaisté pienien karttojen latausaikaa
;mutta voi hidastaa zoomausta ja siirtoa. Arvo kilobittejd (kb)

Diskmap ImageMem=16384

[Fuel Data] -osa

Polttoaineen kulutus voidaan arvioida. Anna arvot kulutukselle /tunti ja nopeudelle

[Fuel Data] -osassa arvona "nopeus=polttoaineen kulutus”

Molemmat nopeus ja kulutus / h annetaan 10 kertaa ilman desimaaliosaa. Nopeus tulee
antaa kolmella numerolla jossa nollat korvaavat tyhjan paikan. Maksimissaan 20 arvoparia.
2 1ahintd arvoa kaytetddn kulloisenkin kulutuksen laskentaan. Polttoaine nédytetd4n lokissa
ja ndyttopaneelin aika-osassa. Poista kulutusarvot kaytosti: uudelleennimed tai
kommentoi (;) pois [Fuel Data] -osa.

Esimerkki:

Aluksesi kulutus on seuraava:
2.81/h @ 0.0Kt (Idle)

4.51/h @ 5.0Kt

8.01/h @ 8.0Kt

22.51/h @ 14.0Kt

35.01/h @ 18.0Kt

65.01/h @ 25.0Kt

Kirjoita seuraavat rivi INI.-tiedostoon:

[Fuel Data]
000=28
050=45
080=80
140=225
180=350
250=650

Komentorivin parametrit

SeaClear tunnistaa seuraavan komentorivin parametrin:
/Ixxxx jossa xxxx on koko polku ja tiedostonimi vaihtoehtoiselle INI-tiedostolle.
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SeaClear lisenssi

Sinulla on oikeus kéyttda SeaClear-ohjelmaa niin monessa tietokoneessa kuin haluat,
seuraavin ehdoin:

SeaClear on tdysin tekijanoikeuksin suojattu ohjelmisto. Sping pidittdd oikeuden olla omistaja,
tekijd ja tekijanoikeuksien omistaja SeaClear-ohjelmalle kansainvilisten tekijanoikeuslakien
mukaisesti.

SeaClear julkaistaan sellaisenaan (engl"as is”), ilman takuita. Missdédn tapauksessa tekija ei ole
laillisessa vastuussa mistddn vahingoista jota timén ohjelman kaytt6 voi aiheuttaa.

Paikalliset lait ja asetukset voivat kieltdd navigointiohjelmiston kdytén. Noudata aina paikallisia
madrayksid ja pidd alkuperiiset kartat ja navigointivilineet esilld kun kéytat SeaClear:ia.
SeaClear ei koskaan saa ldhettdd valvomatonta tietoa millekédédn alusta ohjaavalle laitteelle.

Voit edelleen kopioida ohjelmaa kenelle tahansa yksityishenkilolle tai yhteisolle missa
tarkoituksessa tahansa kunhan muistat etti:

- Etvelota kopioinnista enempié kuin kohtuulliset kasittely ja kopiokustannukset.

- Etyriti esiintyd SeaClear:in nimen tai oikeuksien omistajana.

— Jakelet SeaClear-ohjelmiston tédydellisend pakettina, timdn dokumentin kanssa.

SeaClear on vain navigoinnin apuviline. Se kerd4, laskee ja ndyttia tietoja, mutta ei ole mitddn
takuuta tiedon oikeellisuudesta koska virheldhteitd on useita.

SeaClear ei korvaa navigointitaitoja, eikéd osaa navigoida itsendisesti Kdytd ohjelmaa varoen.
Varmista ettd Sinulla on aina alkuperéiset kartat saatavilla kun kaytét SeaClear:ia.

Kéddntdjd ei ota mitdadn vastuuta termien tai asiasiséllon sdilymisestd alkuperdisen manuaalin mukaisena. Varsinkin
karttaprojektioon liittyvadssd termistossé, jota ei ole kokonaan kddnnetty, voi olla virheellisyyksid. Kuten muissakin kohdissa.
Samoin ohjelman lisenssid koskeva kddnnos ei vastaa lakitekstiltd vaadittavaa tarkkuutta.

Tarkista aina alkuperdiskielisestd manuaalista epdilyttavit kohdat.

Tekstissd on pyritty noudattamaan suomalaisen kielitiedoston termejd, kdyttden avoinna olevaa ohjelmaa taustalla
kddnnostyon aikana.

Kddnnos 20.8.2004/S.N // Linux, pdftotext, Gimp ja OpenOfficel.1 tyokaluilla

Translator does not give any warranty that Finnish manual follows the original manual by terms and original meaning.
Specially terms of chart projections (not fully translated) and the licence section may not be excact enough. Always check
original manual if in doubt.

Finnish manual tries to follow finnish language file terms. Program has been open on background while translating this
manual.

Translation 20.08.2004/S.N // with following tools: Linux, pdftotext, Gimp, OpenOfficel.1
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